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Documentation Conventions  

 
Indicates extra Information  

 
This icon indicates a best practice, or an example. 

Setup>System Setup 
Indicates Menu item shortcuts: An underlined letter indicates this is a “hot 
key”. On Main menus click the Alt button plus that key to go directly to that 
field or function. On Drop Down menus just type that key.  

Field Name   Indicates a Field Name or button Name  

Important  Important information 

Screen Shots 
To conserve space the screen shots are seldom actual size and may have 
blank spaces or other non essential information cropped from them. 

 

Links to other documents or web pages are included when additional 
explanations are available. Click the notebook to find that information.  

Links to other topics 
Various places in this document have links to other topics in the document. 
To return to the original topic click Alt + left arrow. Try it out with the link to 
the left!    

Update Release Notes  

This document contains only the new features contained the software 
updates. For all changes see the release notes on the download webpage. 

Click the release notes button to find these.    

http://www.rfms.com/RevisionHistory.aspx
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RFMS Button Conventions 

 
Exit the current screen. 

 
Access the help file.  

 
Activates or selects the highlighted record. 

  
Add a new record. 

  
Make changes to a record.  

  
Delete a record. 

  
Add or View Notes on a record. 

  
Find a record using specific fields. 

  
Resets a filter.  

 Exact match required in a search. 

 Partial match only required in a search. 

  
Print a document or go to a report menu.  

 
Insert or access an attached picture.  

 
Tag Untag Tagall or Un-tagall record(s). Selects records 

 
View details of a record.  

 
Send an RFMS mail message regarding the highlighted record.  

 
View the history of a record.  

 
View the pdf history of reports for the highlighted record. 

 or  
Click to view the tracking record created for every record insert made into 
Orders, Quotes and Bid Pro Estimates. If gray, no records are present. 

  
Brings up the Client Management remote actions screen and add a CMM 
action or relate a CMM record to this record.  

 

With all date fields in RFMS, hit the D key to fill in today’s date, type in a date, 
use the up and down arrows to move the date one day at a time or click F8 to 
bring up the calendar and then choose the date. 
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Overview 

Enhanced Revenue Recognition Method Overview 
In July of 2002, Congress enacted the Sarbanes-Oxley Act, also known as the 'Public Company 
Accounting Reform and Investor Protection Act' (in the Senate) and 'Corporate and Auditing 
Accountability and Responsibility Act' (in the House). It is commonly called Sarbanes–Oxley, Sarbox or 
SOX. SOX is a United States federal law enacted which set new or enhanced standards for all U.S. 
public company boards, management and public accounting firms 
 
To comply with SOX, RFMS developed the Enhanced Revenue Recognition Method or ERRM. ERRM 
is a feature in RFMS designed to allow journal detail.  It utilizes new Standard Account Codes for 
enhanced journal reporting and real-time General Ledger posting. This feature breaks apart the journal 
summary reports for A/R, A/P, Customer Deposits, Sales, Cost of Sales and Inventory into a detailed 
listing that shows when specific transactions are made. This feature provides a more detailed journal 
listing than what RFMS currently provides particularly in regard to Work In Progress tracking through 
the journal.   
 
ERRM is the most comprehensive approach for reflecting real-time financial position in the General 
Ledger.  
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Authorization Form 

Transition to ERRM should not be considered without appropriate consultation with your Regional 
System Analyst (RSA).  
 
Transition to ERRM is irreversible. 
 
To transition to ERRM, please complete the authorization below and fax back to 831-417-2714. This 
completed document must be received by the RFMS Service Desk to certify that you understand the 
procedural changes that accompany ERRM prior to the ERRM Activation Code being created for your 
system. 

Company Information 

Name: 
       

Position: 
 

Company Name:       
 

By signing this document, I certify that I / we: 
 

• have received and read the document titled "ERRM User Guide" 

• understand the ramifications of using Enhanced Revenue Recognition Model as 
the new system of accounting and operations 

• understand that once transitioned to Enhanced Revenue Recognition it is 
irreversible and the system cannot be transitioned back to the non-ERRM 

configuration  

• understand that records that have been added before transition will not be 
effected by ERRM and will be treated with previous batch-system rules 

• agree to take 2 hours training before turning on ERRM and 2 hours follow up 
training 

• understand use of Access Codes in ERRM can create adjustments not 
recognized by the General Ledger and should be used with extreme caution. 

• wish to move forward with this process by obtaining the access code from the 
RFMS Service Desk. 

 
Signature__________________________________________Date____________________ 
 

Credit Card Information 

 
CC# _______________________ CVC/Security Code_________ Exp Date___________ 

Billing Address  
Address  _______________________________________________________________ 
 

City _________________________ State ___________ Zip _______________________ 
 
Amount _________________ Signature _______________________________________ 
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Additional Standard Account Codes 

Several additional Standard Account Codes will need to be added to the system for ERRM.  Listed 
below are all new account codes and their account type (asset, liability, etc).  Associate the appropriate 
account code from the Chart of Accounts with the newly added Standard Account Codes below.   

Chart 
Account Code Account Code 

Type 
Function Typical Offsetting 

Account 

Receipts Not Deposited Current Asset Receipt Posted / Deposit Not 
Entered 

Customer Deposit / AR 

A/R Unbooked Current Asset Invoice has been sent to client, AR 
aging has started, but revenue 
recognition has not occurred  

AR 

Inventory In Uncosted Current Asset Material received. Invoice has not 
been processed from the vendor.   

Accrued Inventory 

Work in Process Material Current Asset  Material on job site Inventory / Cost of 
Material 

Work in Process % Billing 
Material 

Current Asset  Material projected on to be on job 
site 

Cost of Material % Billing 

Work in Process Labor Current Asset Providers earnings have been 
entered on the order  

Accrued Labor / Cost of 
Labor 

Cost of Labor % Billing Cost of Goods 
Sold 

Labor projected to have been used 
for a job 

Accrued % Billing Labor 

Accrued Inventory for 
Costing 

Current Liability Material received. Invoice has not 
been processed from the vendor.                                            

Inventory in Uncosted  

Accrued Labor Current Liability Providers Earnings have been 
entered on the order 

WIP Labor    

Labor Suspense Current Liability Clearing account that receives 
Accrued Labor that has been 
released to offset against payroll 
through Providers Print and Post. 
Payroll charges should be applied 
to Labor Suspense. 

Accrued Labor 

Accrued % Billing Labor  Current Asset  Labor projected to have been used 
on the job but not yet entered in 
Providers. 

Cost of Labor % Billing 

Cost of Labor Cost of Goods 
Sold 

Book Order WIP Labor    

Cost of Material Cost of Goods 
Sold 

Book Order WIP Material  

Cost of Material % Billing Cost of Goods 
Sold 

Job cost Order WIP % Billing Material 
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Standard Account Codes Worksheet 

Worksheet for Standard Account codes 
 
 
Account Code Account Code Type Account Code 

Receipts Not Deposited Current Asset  
A/R UnBooked Current Asset  

Inventory In Uncosted Current Asset  
Work in Process Material Current Asset   

Work in Process % Billing 
Material 

Current Asset   

Work in Process Billing 
Labor 

Current Asset  

Cost of Labor % Billing Cost of Goods Sold   

Accrued Inventory for 
Costing 

Current Liability  

Accrued Labor Current Liability  

Labor Suspense Current Liability  
Accrued % Billing Labor  Current Asset  

Cost of Labor Cost of Goods Sold  
Cost of Material Cost of Goods Sold  

Cost of Material % Billing Cost of Goods Sold  
 
 
❑Set up DEFAULT providers Earnings wages in Human Resources to Labor Suspense 
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FAQ 

Training to be set up and take place on the Practice Company version of the database  
 
When should ERRM be turned on? 
First, a training session to apply ERRM to the practice version of the database is recommended.  This 
will allow set up to take place and training of staff members prior to setting up ERRM on the real or 
production version of data. 
 
RFMS recommends performing month end closing procedures and reconcile all GL accounts through 
the current month before selecting this option to avoid any confusion.   Preparing and saving the 
standard RFMS month end accounting  reports will help ensure  pre-ERRM transactions are captured 
and to identify records that are in process for future reconciliations and to track activity. 
 
How to prepare for ERRM to be activated? 

1. Sign and return the ERRM checklist/authorization form, which explains the new features and 
changes that ERRM will have on in order entry, job costing, journal transactions and accounting. 

2. Confirm the Practice Company is available and shortcuts in place  
3. Determine NEW Account Codes 
4. Schedule Training 
5. Get Access Code for Training Session 
6. Training session to review system and transaction changes 
7. Internal staff trained on changes to operations 
8. Date determined to activate ERRM on active database 
9. Get Access Code for ERRM for go live date 
10. Reports run end of business the day prior to go live 
11. Create back up copy of dataset and keep in a secure place for future reference 
12. Apply Access Code after reports and back up have been completed 

 
I see there are new comments in my journal, what do they mean? 
 

Costing Inventory This accounts payable invoice was added through the costing function 
in the Inventory module. 

ADD PAYABLE This accounts payable invoice was added through the accounts payable 
module.  This entry in the Inventory account typically indicates mis-
coding as all inventory transactions should be processed through the 
costing function in Inventory. 

Delivery Ticket  The Delivery Ticket has been printed from Order Inventory indicating the 
inventory has physically left the warehouse. 

Line Un-Delivery A user has changed the status on a particular line from Delivered 
indicating that the material is physically in the warehouse. 

EDIT PAYABLE User has edited accounts payable invoice AFTER inventory costing 
Void Payable The indicated invoice has been voided in the Accounts Payable Module 

MONTH END SUMMARY Pre-ERRM transactions. Details will be printable from Print Journal 
Information found in the journal close routine. 

Book Sale Indicates the book sale functions has been selected, typically indicating 
completion of the job. 

Bill Sale Bill Sale function has been selected, creating an accounts receivable. 
Un-Book Sale Reversal of the Booking function. 

Un-Bill Sale Reversal of the Billing function. 
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Pre-Activation Processes 

 
RFMS recommends performing month end closing procedures and reconciling all GL accounts through 
the current month before activating ERRM to avoid timing / crossover issues. Preparing and saving 
these standard RFMS month end accounting reports will help ensure pre-ERRM transactions are 
captured and to identify records that are in process for future reconciliations and to track activity. 
 
The following reports must be created prior to activating ERRM to an active or production database. 
 
These reports should be generated and saved in both PDF and CSV formats prior to activating ERRM. 
 

Month End Accounts Receivables 

  
Accounting>File>Month End>Accounts Receivable 
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Month End Accounts Payable 

  
Accounting > File > Month End > Accounts Payable 

Month End Taxes Due 

  
Accounting > File > Month End > Tax Reports > Print Tax Due 
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Month End Inventory Balance Report 

  
Accounting > File > Month End > Month End Inventory Balance Report 

Check Register(s) 

  
Accounting > File > Banking > Add/Edit Checks > (Register) 

 Print Check Register  

  
Print register from inception to current. 
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Journal Year to Date 

  
Accounting > File > General Ledger > General Ledger Functions > Print Journal 
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Material Analysis 

  
Sales Reports>File> Material Analysis 
 

• Sort by:  Customer/Invoice 

• Line Status:  None, Gen PO, On Order, Reserved, Cut and Delivered  

• Product Codes:  All 

• Salespeople:  All 

• Customer Types:  All 

• Stores:  All 

• Fiber:   All 

• Show Cost, Show Profit 

• Output to CSV 
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Purchase Order Listing Report 
 

       Tag All PO Lines                       Print Tagged PO’s 

 

Inventory>File> Purchase Orders 
 

• All Purchase Orders 

• All Product Codes 

• All Suppliers 

• All Stores 

• Print Listing Report 

• Status to Print:   To Be Ordered, Open, Back Ordered 

 Tag All PO Lines  

  
Select all available Purchase Orders. 

 Print Tagged PO's  

  
Select Purchase Order Listing Report from the available drop down listing. 

1 2 
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Roll Inventory Range Report 

  
Inventory>Reports>Roll Inventory Range Report 

• Sort by:  Date Received 

• Product Codes: Both 

• Stores:  All 

• Roll/Cut:  Both 

• Value:  Current  

• Show Dollars, Include Reserves 

• Uncosted Inventory:   Include Uncosted 

• Physical Size:  From .01 To 999,9999 

• Output to CSV: Save  

Item Inventory Range Report 

  
 
Inventory > Reports > Roll Inventory Range Report 

• Sort by:  Date Received 

• Product Codes: All 

• Stores:  All 

• Value:  Current  

• Show Dollars, Include Reserves 
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• Uncosted Inventory:   Include Uncosted 

• Physical Size:  From .01 To 999,9999 

• Output to CSV: Save 

Inventory Adjustments Report 

  
Inventory > Reports > Inventory Adjustments Report 
 

Activation 

System Option 
To use Enhanced Revenue Recognition, set  
 
Utilities>System Options>System Wide>General>ERRM (Enhanced Revenue Recognition Method) 
to yes. 

 

This can only be activated with an Access Code from the Director of Customer Support. 
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Operational Overview 

There are several other changes to note in the RFMS system upon implementation of ERRM. 
 

• It is important to know that because journal postings are now immediately visible in the journal 
and new standard account codes are utilized, journal printing at month-end will increase 
immensely. We recommend printing all month-end documents to PDF and printing to paper 
only as necessary.  In addition, all accounting activity prior to activation will be treated by 
previous system rules and not ERRM. We recommend that month end procedures are 
performed before selecting this option to avoid transition issues. 

• Transactions will now post to the Journal in real time.  This means there is an immediate 
journal entry for specific procedures. 

Order Entry 

• Express Job Cost is available.  If the Order can be job costed, Express Checkout will bill, book 
and job cost the order.  If the Order is partially through the ERRM process, Express Checkout 
will pick up and finish. 

• Post/Unpost Finance Charges creates individual Journal records instead of a month-end lump 
sum entry. 

• Sales will now need to Billed and Booked.  If changes to the order such as adding, editing and 
deleting are needed, Un-Billing the sale will be required. Changes will create entries in the 
Journal. 

• Once an order has been Billed, the order is then locked for editing with regard to invoice 
dollar totals. 

• Printing a Picking Ticket and Delivery Ticket will be required. The Picking Ticket places 
inventory in a Staged Status.   The inventory module shows the record as "Reserved." The 
Delivery Ticket takes the inventory on the order and changes it from a Staged Status to a 
Delivered Status. Journal entries are associated with printing the Delivery Ticket. 

Inventory 

• Inventory adjustment records are posted immediately to the journal. 

• If material is costed in a month later than the month it was received, cut and delivered and the 
cost is changed; if the journal is still open at the time of costing and the cost changed then the 
system makes the journal entry for the difference back to the journal using the date received. 

• If the cost of inventory is changed and it is not in a costed status the PO cost and on the lines 
will be updated regardless of the line status. The gross cost of the line will only be adjusted if 
the line is not in a delivered or job costed status. If the record is costed and the cost is changed 
the PO cost on the line will not be updated, as an adjustment will be posted for this change. 

•  The system will always update PO Cost on the order entry line when cost has changed (except 
when line is in Job cost status) 

• The system will always update gross cost and net cost on line except when line is delivered or 
job costed 

• The system does not allow editing of cost once material is assigned 

• If there is a cost adjustment to inventory that has a line assignment, the system will update the 
costs on the line. 

• To accommodate tracking not costed inventory, all changes to item cost prior to costing are 
tracked through the history file not the current cost.  

• Inventory adjustment records are posted to the journal as soon as they are made, and will not 
be held in the adjustments file or be on the inventory adjustments report.  

• An order can be voided with no additional processing up until the job is job costed or the 
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delivery month has been closed.  

• When doing a transfer adjustment to another store. If the material has not been costed the 
system will post the original store and credit Materials in Uncosted, Debit Accrued Inventory for 
Costing. The new store will receive a debit to Materials in Uncosted, Credit Accrued Inventory 
for Costing.  

Providers 

There is a Do Not Accrue button located on the Provider record. Selecting this option will keep a journal 
entry from being entered on the provider record regardless of the pay status. This feature can be used 
for any provider records to post against a particular job whether or not they are paid. Examples are 
burdens, freight or provider records which may be held before they are paid. If a provider record is 
entered and Do Not Accrue is not selected a journal entry will be placed in the journal as normal (Debit 
Work in Process Labor and Credit Accrued Labor). If Do Not Accrue is selected later, those entries 
will be backed out of the journal. 
 

In the Supplier file and Worker Information files, the Do Not Accrue pay status can be set on an 
individual Supplier and Worker basis. If a provider record is entered in Order Entry and the record has 
had the Do Not Accrue Status applied, the provider record in Order Entry will inherit that status. 
 
BCOE is no longer allowing ERRM users to Edit or Delete a Provider record, accept for changing the 
Do Not Pay status, where the Installation Date is in a closed Journal period. (Unlike non-ERRM, ERRM 
users CANNOT override and delete with an Access Code.) 
 

If the installation date is edited on a provider’s earning record, the reversing journal entry will be made 
on the original installation date.  

 
Provider Pay Status 
 
In addition, the Pay Status on the Supplier record (in Accounting) or on the Worker record (in Human 
Resources) may be setup. This screen will inherit that setting when entering a provider record. 
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Accounting - Suppliers 
 

In this example, a supplier record has been entered, selected the Pay Status of Ok to Pay and checked 
the Do Not Accrue option. 
 

 
 
When we entered the provider record, the Pay Status and Do Not Accrue information was inherited 
from the supplier file. 
 

 
 
If a provider record is entered and the month of the installation date is closed before the record has 
been marked paid, the record cannot be edited or deleted, otherwise the provider record would no 
longer match the journal for the original month. 
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Human Resources 

Worker Information 
 
In this example we have entered a Worker Information record and selected Ok to Pay as the pay status 
and have not select the Do Not Accrue option. 
 

 
 
The provider record has inherited the information from the Worker Information record. 
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Accounting 

• Batch numbers are used to track transactions. Batch numbers are assigned to a specific set of 
journal entries for one specific procedure, meaning every transaction has its own batch number. 
They are assigned to each journal posting and data can be filtered and tracked based on these 
numbers. 

• All A/P records are posted individually to the Journal when entered. 

• All A/P records are posted individually to Banking transactions. 

• When Viewing the Journal (Accounting, File, General Ledger, View Journal)  it can searched by: 
Supplier 
Invoice # 
Line # 
Provider 
Job Name 
PO 

Roll/Item # 
Item Sequence # 
BOL 
Batch 
 

Viewing the Journal 

Transactions can be isolated and filtered according to various combinations of criteria including: 
 

•Store Code 

•Transaction Date 

•Batch # 

•A/P Invoice 

•Check 

•Transaction Amount 

•Order Information – Invoice #, Line #, Provider, Sidemark 

•Inventory Information – Roll #, Item Seq #, Bill of Lading # 
 
This feature will also allow transactions to be viewed for a particular entry or multiple entries relating to 
one event or the entire group of events posted to the journal. To access this, click File, G/L, View 
Journal. 
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POSTINGS 
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Diagrams 

Accounts Payable 
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Accounts Receivable 

 

Banking 
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Order Entry 

 

Additional Order Entry Facts 

A Reversing Entry will be made to the journal if the line status is changed from Delivered. 
 

A Reversing Entry will be made if the provider record is edited and the installation date is changed, or 
the dollar amount is changed. 
 

The user can bill the order or book the order first, it does not matter in what order this is done. 
 

The user can skip the process of booking and billing and go straight to job cost if all the material lines 
are in a delivered status. 
 

Printing the picking ticket, changes the status on the line from Cut to Staged. 
 

The inventory record will remain in a reserved status until the delivery ticket is printed and the line is 
changed to a delivered status. 
 

Service lines do not have to be in a delivered status before they can be job costed.  Therefore if the 
order is a labor only order then printing a delivery ticket is not necessary. 
 

When an order is billed the order will be included in all Accounts Receivable reports. Statements can be 
run for the order even though the order has not been job costed. 
 

There is an option on the provider record for Do Not Accrue.  If Do Not Accrue is checked, no journal 
entries will be posted to the journal.  A provider history report can be run for the “Do Not Accrue’ 
records. 
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Inventory 

 

Regular Billing 

Postings Chart Regular Billing 

Process Debit Credit 
Receive Inventory Inventory in 

Uncosted 
Accrued Inventory for Costing 

Cost Material Inventory A/P 
  

Accrued 
Inventory for 
Costing 

Inventory In Uncosted 

Print Delivery Ticket Work in Process 
Material 

Inventory 

Post Provider 
Records 

Work in Process 
Labor 

Accrued Labor 

Book the Sale A/R UnBooked Work in Process Material 
  

Cost of Goods 
Material 

Work in Process Labor 

  

Cost of Labor 
Sales 

Bill the Sale  A/R A/R UnBooked 

Post a Payment Receipts Not 
Deposited 
 

Payments received on or before the Bill Date will be 
debited from Customer Deposits, Payments received 
after the Bill Date will be debited from A/R  

Post a Deposit Checking Receipts Not Deposited 
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Percentage Billing 

 
 
Percentage billing allows the recognition of an estimated portion of a job to be realized regardless of 
the actual status of material and labor. Using percentage billing follows all the basic rules of job costing 
with the exception of suspending the cost of goods sold expenses in two standard account codes. 
These two special accounts are reversed at final billing. 

 WIP % Billing Material (Asset)  

  
At the time of job costing, this account receives a credit for the estimated material expense. The 
amount is reversed at the time of final billing of the billing group. Until that time, this amount will appear 
on the Month End Inventory Balance Report. This account is typically located in the asset section of the 
balance sheet, although it will typically have a credit balance. 

 Cost of Mat % Billing (COGS)  

  
At the time of job costing, this account receives a debit for the estimated material expense. The amount 
is reversed at the time of final billing for the billing group. This account is typically located in the cost of 
goods sold section of the income statement. 

 
At the time of job costing, this account receives a credit for the estimated labor expense. The amount is 
reversed at the time of final billing for the billing group. This account is typically located in the asset 
section of the balance sheet, although it will typically have a credit balance. 
 

 
At the time of job costing, this account receives a debit for the estimated labor expense. The amount is 
reversed at the time of final billing for the billing group. This account is typically located in the cost of 
goods sold section of the income statement. 

 

 
WIP % Billing Material (Asset) 

 
Cost of Mat % Billing (COGS) 

 
WIP % Billing Labor (Asset) 

         
        Cost of Labor % Billing (COGS) 
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Specific Changes in Processing  

Receive Material 
New Postings to the Journal 
When using Enhanced Revenue Recognition, new postings will occur in the journal at the time of 
specific transactions (as noted above).  The following example will walk you through the processes that 
now post to the journal in “real time”.   
 

1. Enter your customer order as normal.   
2. Generate a PO for the material on the order as normal.  (From the Customer Order line or 

through the Inventory Module).   
3. Receive Material - When the material for this job arrives, receive it into inventory as normal.  

Postings will occur in the journal showing a Debit to Inventory in Uncosted and a Credit to 
Accrued Inventory for Costing.   

 

 

Issue Picking Ticket 

Issue the Picking Ticket - The next two steps consist of cutting the lines on the order and printing the 
Picking Ticket.   
 

• No journal entries occur during these steps  

• Material lines from their current status to a “Staged” status.   

• Service lines will be put into “Delivered” status. 
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Costing Material 
Costing Material - The next step is to cost the material associated with the sale. 
 

• Journal entries are posted showing a Debit to Inventory and a Credit to A/P.  

• Also a Debit to Accrued Inventory for Costing and Credit Inventory in Uncosted occurs to offset 
the previous entry. 

 
 

When costing inventory if the invoice date is earlier than the date received the reversing entries to 
Inventory in un-costed and accrued Inventory for costing will be posted with the date received. 
Inventory and AP will be posted with the Invoice Date. 
 
Example:  
Invoice Date = June 26, 2016 Date Received = June 27, 2016. 
Inventory received via Bill of Lading 

Debit Inventory in Uncosted=June 26 
Credit Accrued Inventory=June 26 
Inventory Costed 

Debit Inventory= June 27 
Credit AP =June 27 
Credit Inventory in Uncosted=June 26 
Debit Accrued Inventory=June 26 
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Print Delivery Ticket 

Printing the Delivery Ticket – The Delivery Ticket is a new document available when using Enhanced 
Revenue Recognition.   
 

 
 

 
 

 
 

• The Delivery Ticket was designed to ensure that only inventory that has actually left the 
warehouse has been deducted from Inventory.   

• It was also added so that when the warehouse has loaded the material, the lines can be 
selected and printed to reflect this activity. 

• The process of printing the Delivery Ticket moves the line status from “Staged” to “Delivered” 
and creates journal postings.  A journal entry will occur with a Debit to Work in Process 
Material and a Credit to Inventory. 
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• Note that material stays in a reserved status on the inventory record until the Delivery Ticket has 

been printed. 

• The booking and job cost dates cannot be earlier than the delivery ticket date. 

• The delivery ticket cannot be before the date received on the inventory record for the lines being 
delivered.  

• Checks have been put in place so that if the Order Line's Delivery date is in a closed Journal 
period: The status cannot be changed manually, the option is grayed out.   

• The line can also not be deleted. 
 

 

Bill the Sale 

The next step will be to Bill the Sale.   
 

 
 
This option is located under the Job Cost icon.   

• When a Sale is billed there is a Debit to A/R and a Credit to A/R UnBooked.   

 

• The purpose of the Bill the Sale feature is that it gives the opportunity to begin the collection 

cycle. You can bill the sale way in advance. This creates a Balance Sheet non-event. We have 

a debit to an asset (AR) and a credit to an asset (AR UnBooked).  

• The payment date must be on or before the bill date.  
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• For example, there are times when a bill needs to be prepared for work not yet completed in 

order for the payment to be received in a timely manner.  In other cases, a bill must be 

submitted to a contractor by the 15th of one month in order to ensure payment within 30 days of 

that original bill date.  For either scenario, this function adds the billed amount to A/R and this 

amount shows up in all reports as money that needs to be collected.  The offsetting entry is 

booked to A/R Un-Billed and will be reversed when the sale is Booked.   

• Once an order has been billed, RFMS will "lock" the line total. This is because the journal 

entries have been made. Adding and deleting Zero-Total Lines is permitted after Billing as these 

will not affect the amount Billed. Information such as quantity or style can also be edited on 

existing lines, but the line total will remain the same. 

• Changing the order without un-billing the order will result in the journal not balancing with 

subsidiary reports: Accounts Receivable and UnBooked Accounts Receivable. The following 

message will appear if an attempt is made to change once an order which has been billed:  

This Order is in a Billed status. Please unbill this order before making any changes.  
 
The only way to change a line total/or delete a line is by un-billing the order 
 
Disabled Options for a Billed not Booked Order  
If an order is billed but not booked or job costed then the following options within the order will be 
grayed out. In order for the user to make these changes, UN-Billing the order is required. 
 

• Line Total 

• Bundle 

• Export 

• Split Lines 

• Combine 

• Move 

• Credit Memo/Add on 

• Append lines to the order from an estimate. 

• Additional commissions may be entered until the order has been job costed.  

• Lines with a total cannot be added or deleted.  
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Provider Records 

Next in this example, Post Provider records to the order 
 

 
 
When posting a provider record to this order, journal entries will Debit Work in Process Labor and 
Credit Accrued Labor.  

 
 
Print and Post Providers Earnings 
When Print and Post Providers Earnings is selected, Accrued Labor will be debited and Labor 
Suspense will be credited. The actual payroll posting should be charged to the Labor Suspense 
account. Variances after a payroll process should be investigated. 
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Book Sale 

Next, Book the Sale. Booking the Sales counts the sale and costs of the sale in the journal and will 
show on the corresponding financial statement. Click the Job Cost icon located on the toolbar to Book 
the Sale.  
 

 
 

 
 

•To Book the Sale, all lines are required to be in a “Delivered” status and provider earnings must be 

balanced.  



Version 18.0  
 37 

•The Transaction Date cannot be before the Delivery Ticket Date or the Latest Installation Date for 

Providers associated with Order. 

•If vendor invoices have not been posted for inventory; the sale may still be booked. The system will 

use the purchase order value to book costs of sales.   

•Any differences will be settled at the time of Job Costing.   

•When a Sale is booked, the line statuses change to Job Costed and a delivered date displays next the 

order on the Customer Order screen. 

•Note that Tax will be posted at the time a sale is booked. Sales and Use Taxes are posted to the Tax 

Report at the time a job is Booked. The system follows the same rules as before when calculating and 

reporting tax information. 

•Booking and job cost dates cannot be earlier than the delivery ticket date. 

•The following journal entries will be made.   

Debit to A/R UnBooked  Credit to Sales 

 Debit to Cost of Goods Material  Credit to Work in Process Material 

 Debit to Cost of Labor     Credit to Work in Process Labor 

 

 

Job Cost 
Next, Job Cost the order.   

 

•The Close Date of this job is posted and commissions are posted.  

•If job costing is back dated to reflect the actual close date of the job, make sure to also run the delivery 

ticket for that same date or earlier.   

•The Transaction Date cannot be before the Delivery Ticket Date, the Latest Installation Date for 

Providers associated with Order, or any materials invoice date. 

•There are no entries into the journal. .   
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•Commissions are calculated at this point in time (although no journal entries are made) and it is 

important that all invoices have been processed or inventory has been costed to ensure final costs are 

reflected.   

•Commissions are posted to the commission report and are not included in the journal postings at the 

time of Job Cost.  The system follows the same rules and procedures as previous for commission 

calculation and posting. 

•Keep in mind that Un-Costed inventory cannot be job costed. 

•Booking and job cost dates cannot be earlier than the delivery ticket date. 

•Note when job costing a percentage order in percentage partial billing only these entries are 

made. The balance of the entries are made when the full order is job costed. 

o Debit AR  

o Debit and Credit AR UnBooked 

o Credit Sales 

 

   
 

Apply Payment 

Apply a Payment - When a payment is applied to this order there is a:  
Debit to Receipts Not Deposited and a Credit to A/R or Credit Customer Deposits. 
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Post Deposit 

Post Deposit - Finally, when a deposit is posted for the payment received against this order there is 
Debit to Checking and a Credit to Receipts Not Deposited. 
 

 
 

Sales Reports  

 
The materials analysis report now has an additional tab for framing parameters specific to ERRM users.  
Delivery ticket from and two are an option on this tab.  
 

Month End Reporting 

Month End Reports 
Accounting>File>Month End 
 

AR Reports: This report will balance to the AR standard account code.  This report is updated when an 
order is either billed or job costed and no money has been posted to the order.  The order then comes 
off the report when the order has been paid in full. 
 
AP Reports: This report will balance to the AP standard account code.  This report is updated when an 
AP invoice is posted.  The invoice then comes off the report when the invoice has been paid in full. 
 
Accrued Inventory: This report will balance to the Accrued Inventory standard account code.  This 
report is updated when material is received from a bill of lading.  The material then comes off of the 
report when the material is costed. 
 
Accrued Labor: This report will balance to the Accrued Labor standard account code.  This report is 
credited when a provider record is posted and debited when the Print and Post Providers report is run.  
The record comes off the report when the provider record has a date paid. 
 
UnBooked AR: This report will balance to the A/R UnBooked standard account code.  This report is 
updated when an order is billed.  The invoice comes off the report when the order is booked or job 
costed. 
 
WIP Material: This report will balance to the WIP Material standard account code.  This report is 
updated when a delivery ticket is printed and lines are now in a delivered status.  The figures drop off 
this report when the order is booked or job costed. 
As of version 10.6 if material was used on a percentage billed order the amount posted to the WIP 
Material % Billed account code shows on the report. It is also sub-totaled. 
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WIP Labor: This report will balance to the WIP Labor standard account code.  This report is updated 
when a provider record is posted.  The record comes off the report when the provider record has a date 
paid.  (The user must run print and post providers.) 
 
Month End: This report is designed to balance with the Inventory standard 
Inventory Balance: account code.  This report gets updated with the following: 
Report: Roll inventory value is as of date received.  Value = Cost x available amount (Available 
amount = amount available + amount reserved) 
Item inventory value is as of date received.  Value = Cost x available amount (Available amount = 
amount available + amount reserved) 
Cut & Delivered from lines as of cut date on the lines (Pre-ERRM records)  
Roll Inventory Value Un-costed no invoice date on or before date entered.  Value = Cost x quantity 
received. 
Item Inventory Value Un-costed no invoice date on or before date entered. Value = Cost x quantity 
received. 
Percent Partial Billed Material (Pre-ERRM records) 
 

The cost used on inventory reports is the gross cost from inventory history, as the current cost may 
have been updated and will not match back dated reports. 

Work In Process 

Listed below are the column headings of this report and where the numbers originate. 

 
Contract Amount: Total Amount of all orders in the billing group 
 

Change Orders: Amount of change orders.  NOTE:  This amount pulls from the lines on the change 
order.  The invoice has to be marked as a changed order in the billing group in order for this report to 
recognize the invoice as a change order and place the change order number on the report in this 
column. 
 

Adjusted Total: Total of all invoices less any change orders 
 

Del. To Date: Total of all lines by product code that are in a job costed status. 
 

Profit To Date: This number is calculated by taking the Delivered Net Sale amount and subtracting the 
following cost: 
 
Delivered Material Cost 
Delivered Service Cost 

Delivered Overhead Margin Cost 
Delivered Freight Cost 
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Delivered Tax Cost 
 

GP%: GP% is calculated on the delivered (job costed) portion of the sale.  To calculate the GP%: 
Profit to date \ Del. To Date = GP% 
 

% Del.: % Delivered is how much of the job that has been billed so far.   
To calculate the % Delivered: Delivered to Date / Contract Amount = % Delivered 
 

Current Shipped: For Non-ERRM users current shipped not job costed are lines on the Not Job costed 
order that a picking ticket has been run for, therefore the lines are in a delivered status. 
 

For ERRM users current shipped not job costed are lines on the order that a delivery ticket has been 
run for, therefore the lines are in a delivered status. 
 

Current: Current not shipped is the value of all lines in the billing group by product  
Not Shipped: Code that are not in a delivered or job costed status 
 

Projected Cost: Cost of all lines by product code in the billing group that are not in a undelivered, 
delivered or job costed status. 
 

Projected Profit Undelivered: Projected profit on all lines in the billing group by product code that are 
not in a delivered or job costed status.  To calculate the % undelivered profit: Contract Amount – 
Projected Cost = Projected Profit Undelivered. 


